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Word 2007 Intermediate handbook

Working with sections and columns

Objectives:

1. Use various types of breaks (column, continuous, next page section) to create
sections in a document.

2. Format text into multiple columns.
3. Enter and sort text in columns.

Sections

Create different sections in a document using various types of breaks.

1. Place your cursor where you wish to insert the section break

2. Go to the Page Layout ribbon/Page Setup group and click the Breaks button.
3. Select the type of break you wish to insert.

o Insert Page Layout References 9 ¥= Ereaks T A Watermark = Indent
= P Break
'y Orientation = [¥= Breaks ~ = ;age
Ij Size i:_‘ILiHE Mumbers = >4 K“Iark the paint atwhich one page ends
Margins = ﬁ and the next page begins,
o EE Columns ~  bi Hyphenation =
I Column
Page Setup e Indicate that the text fallowing the column
é—' break will begin in the next column,
I Text Wrapping
= Separate text around abjects an web
pages, such as caption text from body text,
Section Breaks
Mext Page
B Insert a section break and start the newr
—_— section on the next page,
Continuous
E Ihsert a section break and starkthe new
— section on the same page,
T Even Page
Inserta section break and start the new
'Ztﬁ section on the next ewven-numbered page.
i 0dd Page
Insert a section break and starkthe new
P:Li;ﬁ section on the next odd-numbered page.
Section break type | New section will begin
Next page On the following page
Continuous On the same page
Odd page On the next odd numbered page
Even page On the next even numbered page
www.microsofttraining.net Tel: 0208 682 4973 Page 1
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Columns
Format text into multiple columns

1.
2.

Select the text to be formatted in columns.
Go to Page Layout/Page Setup group and click the Columns button.

Use the More Columns... option to create more than three columns, change column
width or spacing.

-

@ =

kore Calumns..,

2.
i3
—/I Home

n'

Themes

Ihnzert Page Layout References

'y Orientation = = Breaks =

[ Size - £ Line Mumbers -

- Margins —— ae .
= ' = E= C-:ulumns*| ke Hyphenation =
Themes | i
= Qne 1
(L] 1 — | B
- s, Cofrper
- =| T
. ==
™ = Three g :
’ == hiective:

Enter text in columns

1.

www.microsofttraining.net
© Best STL 2008

On the Insert tab, the galleries include items
that are designed to coordinate with the overall
look of your document. You can use these
galleries to insert tables, headers, footers, lists,
cover pages, and other document building
blocks. When you create pictures, charts, or
diagrams, they also coordinate with your
current document look. You can easily change
the formatting of selected text in the documen
text by choosing a look for the selected tght
from the Quick Styles gallery on the Home fab.

You can also format text directly by usigg the
other controls on the Home tab. Most gpntrols
offerachoice of using the look from thefcurrent
theme or using a format that youf specify
directly. [I start typing here and text afljusts to
overflow into the next column. To change the

Click within one of the columns where you wish to enter text and begin typing.
2. Text will ‘overflow’ into the following column

overall look of your document, choose new
elements on the Page Layout tab. To
e the looks available in the Quick Style
, use the Change Current Quick Style Set

Bgth the Themes gallery and the Quick Styles
llery provide reset commands so that you can
lways restore the look of your documentto the
original contained in your current template. On
the Insert tab, the galleries include items that
are designed to coordinate with the overall look
of your document. You can use these galleries
to insert tables, headers, footers, lists, cover
pages, and other document building blocks.
When you create pictures, charts, or diagrams,
they also coordinate with your current
document look.

Tel: 0208 682 4973
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Inserting a column break

1.

Click at the start of the sentence you wish to appear at the top of the next column.
2. Go to Page Layout/Page Setup group and click the Breaks button.
3. Select Column from the list of options.

On-the- Insert- tab,- the- galleries-include-items-
thatare-designedto-coordinate-with-the-overall-
look- of- your- document.- You- can- use- these-
galleries-to-insert-tables,-headers, footers, lists,-
cover- pages,- and- other- document- building-
blocks.- When: you- create- pictures,- charts,- or-
diagrams,- they- also- coordinate- with: your-
current-document-look.-You- can-easily-change-
theformattingofselected4extinthe-document-
text by- choosing: a- look: for-the-selected-text-
from-the-Quick-Styles-gallery-onthe-Home-tab.q|
You-can-also-format-text-directly-by- using- the-
other-controls-on-the-Home-tab.-Most-controls-
offerachoice-ofusing-thedook-fromthe-current-
theme- or- using- a- format- that- you- specify-

I-start-typing-her
intothenextcolu
ofyourdocumen
on-the- Page- Lay
available- in- the
Change-Current-
Both-the-Theme
galleryprovide+e
alwaysrestoreth
original-containe
the-Insert-tab,-t
aredesignedio<c
of-your-docume
to- insert- tables,
pages,- and- oth

direc‘th."_- ..................... Colurnn Break, < ccoeeeeeeiens

Sorting columns
1. Select the column text to be sorted.

When-you-creat:
thev- alsn- con

A
2. Go to Home/Paragraph group and click the Sort |24 button.

w

4. Click OK.

0 B-On-the Insert-tab,-the-galleries-include items-
thatare-designedto-coordinate-with-the-overall-
look: of- your- document.- You- can- use- these-
galleries-to-insert-tables,-headers,footers, lists,-
cover- pages,- and- other- document: building:
blocks.1]

A. When- you- create- pictures,- charts,- or-
diagrams,- they- also: coordinate- with- your
current-document-look.-You- can-easily-change-
the formattingofselectedtext-in-the-document:
text- by- choosing- a- look- for-the-selected-text:
from-the-Quick-Styles-gallery-onthe-Home-tab.q
C-You-can-alsoformattext-directly-by-using-the-
other-controls-on-the-Home-tab.-Most-controls-
offerachoice-ofusing-thedook-from-the-current-
theme- or- using- a- format- that- you- specify-
directly.- To- change:- the- overall- look- of- your-

www.microsofttraining.net
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Select Paragraphs and Text, and sort option (Ascending or Descending).

9 A. When- you- create- pictures,- charts,- or-

diagrams,- they- also- coordinate- with- your
current-document: look.- You-can-easily-change-
theformattingofselectedtextinthe-document:
text- by- choosing- a- look- for-the-selected- text-
from-the-Quick-Styles-gallery-on-the-Hometab.1]
B-On-the Insert-tab,-the-galleries-include-items:
thatare-designed+to-coordinate-with-the-overall:
look- of- your- document.- You- can- use- these:
galleries-to-insert-tables,-headers, footers, lists,-
cover- pages,- and- other- document- building:
blocks.q

C-¥ou-can-also-formattext-directly-by-using-the-
other-controls-on-the-Home- tab.-Most-controls-
offera<choice-ofusing-thedockfrom-the-current.
theme- or- using- a- format- that- you- specify-
directly.- To- change- the- overall- lock- of your:

Page 3
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Practice Activity: Working with Sections and Columns

Open Hierarchy details.docx.
Resave the document as My hierarchy details.

Format the text underneath the document heading (Zenith Garments Inc...) into
three columns.

4. Change the spacing between the columns to 1 centimetre, and display a line
between the columns.

5. Insert a column break immediately before Regional Managers in the first column
and before South Region in the second column.

6. Reformat the text in the document into one column, and delete any column or section
breaks that remain in the document.

Turn on the Show/Hide button | T on the Home ribbon to see where any remaining
breaks are located in the document.

7. Save and close the document.

www.microsofttraining.net Tel: 0208 682 4973 Page 4
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Formatting tables

Objectives

1. Modify a table by aligning text, merging cells, changing text orientation, and resizing
rows and columns.

2. Highlight table cells by adding borders and shading .
3. Use the Table Styles command to format tables and set a default table format.

Creating a table
1. Go to Insert/Table group and click the Table button.
2. Either:
a. Select the number of columns and rows required from the grid, or
b. Use the Insert Table option, specify number of columns and rows and click OK.

LjJqui
Table Picture Cllp Shapes Smi
Insert Table
N O {
N O {
N O {
N O {
N O {
N O {
N O {
N
= InsertTable...

Modifying a table

Aligning text

1. Select the table text to be aligned.

2. Go to Table Tools Layout/Alignment group and select the alignment option you wish

to use.
o MName 9 Table Tools
Developer Design Layout
April
EEE A J ,—il
Jeff §|§ = — Z
Text Cell Sort
Lesley =l =l = pirection Margins
Alignment
Name
April
leff
Lesley
www.microsofttraining.net Tel: 0208 682 4973 Page 5
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Merging cells

1. Select the cells to be merged (joined) together.

2. Go to Table Tools Layout/Merge group and click Merge cells.
The selected cells are now joined together into one cell.

0 Flight details

Arrival Departure

Shading

@ Table Tools

Design Layout

i Merge Cells
5 split Cells
—3 Split Table

Merge

Flight details

Arrival Departure

1. Select the cells you wish to apply shading to.
2. Go to Table Tools Design/Table Styles group and click Shading.

Borders

1. Select the cells you wish to apply border to; or remove borders from.
2. Go to Table Tools Design/Table Styles group and click Borders.

Shading

Table Tools

Design Layout

&3 shading -

Borders

Table Toals

& Theme Colors

LN AN ENEN

Standard Colors
HE EEEER

Mo Colar

1) More Colors...

www.microsofttraining.net
© Best STL 2008

Design

Layout
&9 shading - || ——— -
ordersq 1% pk

Eottom Border

Top Border

Left Border

Right Border

Mo Border

All BEorders

Cutside Borders
Inside Borders

Inside Horizontal Border
Inside Vertical Border

: Diagonal Down Border
Diagonal Up Border
Horizontal Line

Draw Table

View Gridlines

=4
=
O

Borders and Shading...

Tel: 0208 682 4973
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Using Table Styles
Applying a table style
1. Click inside the table.

2. Go to Table Tools Design/Table Styles group and click on a Table Style to apply the

design to your table. Use the dropdown arrow = to the bottom right of the visible
Table Styles to view further options.

Documentl - Microsoft Word Table Tools

ut References Mailings Review View Developer Design Layout

£ Shading -

Setting a Table Style default
1. Right-click on the Table Style you wish to set as the default.
2. Select the Set as Default option.

3. Select the default table option you wish to use (for this document only, or all
documents based in the Normal template).

2 Default (3 I Default Table Style

Style:  Light Shading - Accent 2

Apply (and Clear Formatting)
Do vou want to set this style as the defaulk table style For:

Tabl Apply and Maintain Formatting
() This document, only?
G- - [Mew Table Style () all docurents based on the Mormal, dotm kemplake?
Modify Table Style -
1 K i [ Cancel

Delete Table Style
Set as Default

www.microsofttraining.net Tel: 0208 682 4973 Page 7
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Practice Activity: Formatting Tables

Open Yearly sales.docx.

Resave the document as My yearly sales.

Align text in the table to the left horizontally, and centre vertically.

Shade the first row of the table in blue.

Merge all cells in the first row of the table, and centre align the text in this row.
Remove the borders from the table.

N o o bk owbhd-=

Save and close the document.

www.microsofttraining.net Tel: 0208 682 4973 Page 8
© Best STL 2008



Word 2007 Intermediate handbook

Working with imported data

Objectives

1. Import an Excel workbook into Word

2. Use formulas to perform calculations in a table
3. Move tables in a document

Import an Excel workbook into Word
1. Go to Insert/Text group and the click Object button.
2. Select the Create from File tab, and click Browse.

3. Select the Excel file you wish to import data from, click Insert then OK.
Data from the first sheet in the Excel file is imported into the Word document.

o A 2| Quick Parts ~ | % Signature Line ~ 9

< wordart - (5} Date & Time Croate New || Creaate Fram e
Text = B _
Box~ 2= Drop Cap ?ﬁomedv File name:
Text —
9 o)y Hd9-6) - Document! - Microsoft Word

a

=/ Home | set | Pagelaout  References Mailings  Review  View  Developer

] Cover Page ~ EE [ Z 9, Hyperlink =
N |2 el 88 (2 72 i) | S50 5 B 5

— Table Picture  Clip Shapes SmartArt Chart Header Footer Page
Y= Page Break 5 At - 4] Cross-reference | - i

Pages Tables Tilustrations Links Header & Foater
El 2 1 g 1 2 3 4. H £ % 8 k] 10 1

= Emp # Name Qtri Qtr2 Qtr3
= E005 Audrey Kress £10,000| £5,000 £9,000
3 EQ02 Jen Herald £20,000 £6,500 £5,500]
L] EOO1 James Hanowver £18,000 £9,000 £9,700
o E004 Julie George £11,000| £8,500 £7,700)
- EQ003 Alan Monder £12,500 £7.000] £11.000|
& Total quarterly sales

Notes:

=  When you double-click on the table, the spreadsheet data can be edited using MS
Excel features.

= |f you wish to create a link between the Excel spreadsheet and the imported data in
Word, check the ‘Link to file’ box before clicking OK in step 3 above.

www.microsofttraining.net Tel: 0208 682 4973 Page 9
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Using formulas in a table

1. Click in the cell where you wish to create a total (or other calculation).

2. Go to Table Tools Layout/Data group and click the Formula button.

3. Check the Formula box, select a number format if required and click OK.

O [Qtr @  TableToois (3)
21333 Design Layout T;Bﬂ?;BOVE)
EEUEU = F Banaat Header B Mumber format:
1563 A= J ,El ) Repest Headr Rows . =
== Convert to Text Paste Funictian:
17895 Text Cell Sort b F I v
2315k rection Margins armula
0784 iment Data
I_

Notes:

=  SUM refers to the SUM function, which is used to add numbers together. (ABOVE)
or (LEFT) refers to the location of the cells containing the numbers to be added, in
relation to the cell where you are creating the formula.

= The Paste Function dropdown box can be used to select a different function, e.g
AVERAGE to create an average instead of a total.

Moving a table

A table can be moved with the mouse (drag and drop) using the icon that appears in the
top left corner of the table, as shown below.

=

Alternatively, click on the icon shown above to select the whole table then use Cut and
Paste to move the table.

www.microsofttraining.net Tel: 0208 682 4973 Page 10
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Practice Activity: Working with imported data

Open Yearly sales.docx.
Save the document as Tables.

Create a new row at the bottom of the table in the document.

>N =

Create formulas to provide total sales at the bottom of each of the columns for
Quarter 1, Quarter 2, Quarter 3 and Quarter 4.

5. Underneath the table you have been working with, import the data from
Total sales.xlsx.

6. Save and close the document.

www.microsofttraining.net Tel: 0208 682 4973
© Best STL 2008
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Using Styles and Building Blocks

Objectives

1. Use styles to format text in documents
2. Modify and delete styles

3. Use styles to create outlines

4. Use Quick Parts

Using Styles
Applying a style
1. Click into or select the paragraph you wish to apply the style to.

2. Go to Home/Styles group. Click the dropdown arrow ~ to view all the styles
available in the Styles gallery.

3. Click on the style you wish to use to apply the style to the selected paragraph.

Home
o Flavoring - Qils e
AaBhCcDe | AaBeCcDé AaBb( AaBb(
T Mormal T Mo Spaci... Headingl Title =
Styles
©
AaBb(
Heading 1
Styles
iHeading 1
Flavoring - Oils
www.microsofttraining.net Tel: 0208 682 4973
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Modifying a style
1. Click the Options button " in the bottom right corner of Home/Styles group .
2. The Styles palette appears on screen.
3. Hover your mouse over the style you wish to modify (i.e. change the appearance of).
4. Click the dropdown arrow to the right of the style you are modifying.
5. Select Modify.
6. Make the desired changes to the style.
7. Click OK, then OK again.
il e = o Heading1 v
cer Update Heading 1 to Match Selection
Arial

4 Modify...
Arial, Bold

Asial_ Left 063 cm (6 J Modity Style 2X

Propetties
Footer T Mame: Heading 1
MNormal bl Style based on: T Mormal
Style For Following paragraph: | 7 Mormal
Pﬂge Number a Formatting
R Cambria (Headings, » || 16+ ‘;‘ Fa | Automatic ~
Heading 1 3 . -
E| = = E ||=) = = | 1= 12| £ £
Blueberry Flavoring 0il

i Font: {Default) +Headings, 16 pt, Bold, Kern at 16 pt, Space Before: 12 pt, After: 3 pt, Keep with
Show Preview next, Lewel 1, Style: Linked, Quick Style, Priotity: 10, Based on: Mormal, Following style: Marmal

[] pisable Linked Styles
Add to Quick Style list [ ] Automatically update

Options. o @ ©nly in this document O Mew documents based on this template

www.microsofttraining.net Tel: 0208 682 4973 Page 13
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Deleting a style

1. Click the Options button " in the bottom right corner of Home/Styles group .

2. The Styles palette appears on screen.

3. Hover your mouse over the style you wish to delete.

4. Click the dropdown arrow to the right of the style you are deleting and select Delete.

Styles *

w

Clear all
Arial

Arial, Bold

Arial. Left- 0.63 cm |'v

S4  Modify Style...
Select All 40 Instance(s)
Delete...

Creating an outline using styles
1. Go to View/Document Views and select Outline.

2. The document appears in Outline view, and the Outlining ribbon appears at the top
of the screen.

0 View

EIREEREEE

Print Full Screen 'Web |Outline| Draft
Layout Reading Layout

Document Views

-
9 Cutlining Home Insert Page Layout References Mailings Review View [

@ Show Level: - :
|48 < |[BoayTedt - |[@ || o nowiee = ; =
W Show Text Formatting —
| & &= = . . Show Close
Show First Line Only Document Subdo ents || Qutline View
Cutline Tools Master Document Close
www.microsofttraining.net Tel: 0208 682 4973 Page 14
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The group of buttons shown below allow you to change Heading styles currently applied
to selected paragraph.

wd @ | Level 1 | o

Text in the document can be collapsed or expanded to view either just paragraphs
formatted with Heading styles; or to view all text.

g =

The Close Outline View button closes Outline view and returns the document to the view
it was displayed in previously (usually Print Layout view).

Close
Outline View

Close

www.microsofttraining.net Tel: 0208 682 4973 Page 15
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Using Building Blocks
Creating a building block

1. Select the text or graphic that you want to save as a building block.
To store paragraph formatting (e.g. indentation, alignment) with the entry, include the
paragraph mark ( 1) in the selection.

2. Go to Insert/Text group and click the Quick Parts button.
Click Save Selection to Quick Part Gallery.
4. Fill out the information in the Create New Building Block dialog box, and click OK.

w

Insert
° E@T www.microsofttraining.net 2
STL 02086824973 =] Quick Parts ~| |2 Signature Line ~ | T Eqg
1| Document Property 3
=] Field..

EBuilding Blocks Organizer...

Save Selection to Quick Part Gallery...

D}‘ et Maore an Office Online...

9 Create New Building Block

Tame: |Best logo 1] |
Gallery: |Quick Parts w |
Category; |Genera| L% |
Description:
SAvE in: |Bui|ding Blocks, dokx w |
Options: |Insert content only w |
814 l ’ Cancel l
www.microsofttraining.net Tel: 0208 682 4973 Page 16
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Inserting a building block

1. Go to Insert/Text group.

2. Click the Quick Parts button and select Building Blocks Organizer.
3. Select the Building Block you wish to use and click Insert.

O  Insert (3} Building Blocks Organizer Ex)

Bulding blocks: Click 2 building block to see its preview
Name: Gallery Category Template A ~
i - i i - Best Training  AutoText General Hormal, dotm
J QUICK Parts _ﬁ Slgr'latu re Line H AutaText General Hormal, dotm
HE AutoText General Movrnal dotm
wiorks Cited  Bibliographies  Buit-In Bullding Block,
E] Document Pro pe rb_.-' Bbiography  Bibliographies  Buit-In Bulding Elock. ..
= Exposure Cover Pages  Buit-In Bulding Block .,
Motion Cower Pages  Built-In Bulding Block.
) Conservative  CoverPages  Buit-In Bulding Eiock...
[_|] Field... Austere CoverPages  Buit-In Building Black...
= Alphabet CoverPages  Buit-In Bulding Block .,
Cubicles Cower Pages  Built-In Bulding Block.
p—— i Puzale CoverPages  Buit-In Bulding Eiock...
Q Bu||d|ng Blocks O rganizer... Mad CoverPages  Buit-In Bullding Biock...
= Pinstripes CoverPages  Buit-In Bulding Block .,
Stacks Cower Pages  Built-In Bulding Block.
Sideline CoverPages  Buit-In Bulding Eiock...
Transcend  CoverPages  BuitIn Bulding Block. ..
Contrast Cower Pages  Built-In Building Block.
Tiles CoverPages  Buit-In Bulding Eiock. ..
Annual CoverPages  Buit-In Bulding Eiock. ..
Fourier Series  Equations  Buit-In Bulding Block. ..
Trig Idertity 2 Equations Buit-In Building Block.
Pythagorea,., Equations  Buit-In Bulding Eiock...
Binomial The... Equations  Buit-In Bulding Block .,
TrigIdertity 1 Equations  Buit-In Bulding Block ..
Expansiono... Equations Buit-In Building Block.
Taylor Expa.., Equations  Buit-In Bulding Eiock...
Areaof Crde  Equations  Buit-In Bulding Block .. v
Quadratic F... Equations Buit-In Buldng glock... |
< >
Edt properties... | [ pelete | [ Insent

Notes:

= Any Building Block you have created and saved yourself should appear at the top of
the list when the Quick Parts button is clicked. To insert, click directly on the item.

= To use items from the AutoText gallery, type the first few letters and press the F3 key
to get Word to put in the rest of the entry. This will work provided the first few letters
you type in are different from the first few letters in other AutoText entries.

www.microsofttraining.net Tel: 0208 682 4973 Page 17
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Practice Activity: Using Styles and Building Blocks

Open Hierarchy details.docx.
Save the document as My organisation structure.

3. Apply Heading 1 style to the headings President, General Manager, Vice
Presidents and Regional Managers.

4. Modify Heading 1 style as follows: change the font to Cambria and change the font
size to 14pt.

5. Apply Heading 2 style to the headings North region, South region and East
region.

Modify Heading 2 using settings of your choice.
In a new paragraph at the end of the document, enter the text Zenith Garments Inc.

Select the text, and create a building block from it (Insert/Text group/Quick Parts
button).

9. Delete the text Zenith Garments Inc, and insert it again using the Quick Parts button.

10. Save and close the document.

www.microsofttraining.net Tel: 0208 682 4973 Page 18
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Working with Headers and Footers
Objectives

1. Create first page headers and footers, different headers and footers for odd and
even pages, and section headers and footers.

2. Add page numbers to your document

Accessing the header/footer area
1. Go to Insert/Header & Footer group.
2. Click the Header button or Footer button, then select Edit Header or Edit Footer.

First page or odd and even page header/footer
1. Go to Page Layout/Page Setup group and click the Options button = .
2. Select the Page Layout tab in the Page Setup dialogue box.

3. Check the desired option from within the Headers and Footers area on the Page
Layout tab and click OK.

Margins Paper Lawouk

Section

Section start: [ew page

Headers and Fookers
[] ifferent odd and even
[] mifferent First page
Header: |1.27 o

4

From edge: -
Fooker: |1.27cm o2
Page
Yertical alignment: | Top W
Prewview
apply ko: [Whole document [Line Mumbers, .. l [ Borders, .. ]

-

www.microsofttraining.net Tel: 0208 682 4973 Page 19
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Section headers and footers
1. Create a header or footer for Section 1.

2. Go to Header & Footer tools Design tab/Navigation group and click Next Section.
This will take you directly to the Header or Footer at the start of the next section in
the document.

3. Before editing the header or footer, click the Link to Previous button in the Navigation
group.

4. Edit and click the Close Header and Footer button.

1] (2 Header & Footer Tools
Design
Chapter 1
J E Previous Section

Chapter 1: Introduction . 7 |l Nexdt Section

GO fo [
Header Footer ‘%%Linktn Previous

Header -Section 1-

Mavigation

3]

‘%%Linktu Preuinus| 9

Close Header
and Footer

Close

Chapter 2|

Header -Section 2-

Chapter 2: Our products

Page numbering
1. Go to Insert/Header & Footer group and click the Page Number button.

2. Select Top of Page and choose from one of the preset options to select where you
would like the page number inserted.

ﬂ

Page
Mumbier ~

Top of Page
EBottom of Page
Page Margins

* w v ¥

LCurrent Position

Format Page Mumbers...

PR EED D E

Remowe Page Mumbers
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Practice Activity: Working with Headers and Footers

Open Spice.docx.
Resave the document as My Spices.

Insert next page section breaks above each of the headings: Cloves, Cinnamon
and Pepper.

Create a Section 1 header containing the word Spices.

Create a Section 2 header containing the words Spices: Cloves.
Before changing the header text, remember to click the Link to Previous button.

6. Create a Section 3 header containing the words Spices: Cinnamon.
Before changing the header text, remember to click the Link to Previous button.

7. Create a Section 4 header containing the words Spices: Pepper.
Before changing the header text, remember to click the Link to Previous button.

8. Add page numbers to the bottom right of all pages in the document.

Save and close the document.
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Working with Graphics

Objectives

Insert pictures into a document.

Create SmartArt diagrams.

Insert WordArt and symbols into a document.
Create watermarks.

Use drawing objects in a document

Create borders and add shading to text

ok wN =

Inserting pictures

1. Go to Insert/lllustrations group and click Picture.
2. Navigate to and select the picture to be inserted.
3. Click Insert.

o Insert Page Layout References Mailin

= 8P =

Table Picture| Clip Shapes SmartArt Chart

- Art -
Tables || INustrations
9 Insert Picture @
Lookip: | [ PUBSOCOR v| @ O XCisE-
s My Recent ] s - ) y w s
i I Y | -
@Desktop
&a00103_,GIF AGO0120_,GIF AE00126_GIF AE00129_GIF AE00130_GIF
= My
llJDocuments
My (\ p
Computer \ﬁq J
\.3 Ty Metwork J ‘ &
Flaces @ -
AGO0135_,GIF AGO0139_GIF AGO0142_.GIF AGO0154_GIF AGD0157_.GIF
e
File: narne: | |
Files of bype: iAII Pictures (*.emf;* wwmf;* jpg; . jpea;® fF;* jpe;* png;® bmp; * dibg* rle;* bz *, aif;* of a;*.emz v|
Insert vl [ Cancel
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Inserting SmartArt

1. Go to Insert/lllustrations group and click SmartArt.

2. Select the SmartArt diagram you wish to use from the gallery and click OK.

3. Enter text either directly into a shape in the diagram, or into the text panel to the left.

o Insert Page Layout References Mailin
M d B8 @ 2 al
I Fici| IR B=
Table Picture Clip 5Shapes Smartart| Chart
- .l'!l.l't -
Tables || Tlustrations [
@ Choose a SmartArt Graphic
a0 A Y 55 688 #
§ List Process
¥ Process
T Cyde sea| T gae QO
stn  Hierarchy . B
B4 Relationship a'h - P
Matrix
Basic Process
A2 Pyramid : v
- —— B Y| o e
B8 BE asas T ¥
QK l [ Cancel
9 Type your text here X
.|
s [Text]
[Text] [Text] [Text]
s [Text]
Notes:

= To add a shape to the diagram, use the text panel. Click at the end of the text
entered into the shape before/above the new shape you wish to create and press
Enter.

= To delete a shape, use the text panel. Select the text inside the shape to be deleted
and press the Delete key.
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Inserting WordArt

1. Go to Insert/Text group and click the WordArt button.

2. Select a WordArt style from the WordArt gallery.

3. Enter the text to appear in the WordArt style you have chosen, and click OK.

# :
(1] A 2| Quick Parts ~ |2 Signature Line ~ (2] n_l . [l wordart | (5], Date & Tin
. A wordart ~| 5] Date & Time WendArt ‘wnmrt worda,, Wordar|

Box~ LSS Drop Cap -~ Pgd Object -

Tex A Wtk e | WOIOASYIE3]

9 Edit WordArt Text
Font:

F Size:
|"F[-Arial Black. "|

Text:

Your Text Here

www.microsofttraining.net Tel: 0208 682 4973 Page 24

© Best STL 2008



Word 2007 Intermediate handbook

Inserting symbols

1. Go to Insert/Symbol group and click the Symbol button.

2. Select a symbol from the items displayed immediately below the button, or select the
More Symbols option to view further symbol shapes.

3. Select a symbol, click Insert then Close to exit the Symbol dialogue box.

9 equation- @ [£2 Symbol -|

€ symbol - & 0 8 0 6
2 O m *x =2
Symbuols ~ B € f ¥
a ™ # <
L2} Mare Symbals...
(S symbol R
Symbols | Special Characters
Fort: |'Wingdings w
003 e e ® D ooeeo"
00 Q00duxs Rr|oGh 21| * | o
OO0 |®|@|O 2R AR Ik Ik 2F
B | 4| 0| O || X OO DD DD
Recently used symbols:
elo|eloe|o|o|m|:|>t|Hle|e|y|o
‘Wingdings: 184 Character code: (154 From: | Symbol (decimal) | v
[&utoCorrect... ] [Shortcut Key... I Shorkcut key:
Insert ][ Cancel
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Creating a watermark

1. Go to Page Layout/Page Background group and click the Watermark button.

2. Select a preset watermark option or select Custom Watermark to create your own.
3. If creating your own watermark, select the Text watermark option, enter your text and

click OK.

0 Page Layout

A] Watermark ~
{'fj Page Color -

;ﬂ Page Borders
Page Background

9 ] Watermark *| | Indent Spacing ]
Confidential <>
COMFIDENTIAL 1 COMFIDEMNTIAL 2 DO NOT COPY 1
DO NOT COPY 2 -
4 | Custom Watermark...

9 Printed Watermark

Language:

Texk:
Fonk:
Size:

Calor:

Layiouk:

() Mo watermark:
) Pickure watermark,

|English (1.5 ~ |

|ASAF v|
|Calibri v |
|.0.ut|:| R |

| V| Serittansparent
(%) Diagonal ) Horizonkal

[ apply l [ [0]'4 ] l Cancel
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Creating shapes

1. Go to Insert/lllustrations group and click Shapes.

2. Select the shape you wish to create.

3. Move your mouse onto the page, click and drag diagonally to create the shape.

‘R ° ™ S

Picture ﬂ:ftj Shavpes smartArt Chart Shavpes SmartArt Chart ) Cross-referenc
INustrations Recently Used Shapes
E~NO0OOALL2S G
CERSA

. Rounded Rectangle |
Lines

Creating borders

1. Go to Home/Paragraph group and click the dropdown arrow to the right of the
Borders button.

2. Select the Borders and Shading option at the end of the list.

3. Use the Border tab to apply a border to a paragraph; or the Page Border tab to apply
a border to a page.

(1) (=~ 1=- ‘a?—_vué? §§'|%l|| q| (2] | Q] Borders and Shading...
== = == || S
Paragraph ]
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Text shading
1. Select the text to be shaded/highlighted.

2. Go to Home/Font group and click the dropdown arrow to the right of the Text
Highlight Color button.

3. Select a colour to apply to text.

Home
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Practice Activity: Working with Graphics

Create a new Word document.
Save the document as Organisation chart.docx.
Change the page orientation to Landscape (Page Layout/Page Setup group).

w2

Insert the Organisation Chart SmartArt diagram, from the Hierarchy category in
SmartArt.

Create the diagram shown on the following page.

6. When you have finished creating the organisation chart, insert the picture
zenith_logo.jpg (image of the coathangers) as shown on the following page.
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W Wé’

m\

Zenith Garments Organisation Chart

President

General Manager
Mac Thomas

Vice President Vice President Vice President Vice President

Nancy Boyette Jacob Drew Michele Bronte Jackson Jones
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Templates

Objectives:
1. Use a template to create a document
2. Create a template

Using an in-built template

1. Go to the Office Button and select New

2. Click Installed Templates.

3. Select a template and click the Create button.

1 @ H9-0 2] New Document

Templates

=

ol Blank and recent

Installed Templates

© Installed Templates
Fax
Mew Elog Post Equity Fax
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Creating a custom template
1. Click the Office Button button and select Save As, then Word Template.
2. Check the Save as type box and change to .dot if necessary, enter a filename and

Save.
(1) e | (L) = Document2
'@r |
Sa f the d t
j New ve a copy of the documen
&;‘ Word Document
~ = Save the document in the default file
y Open format.
E:.‘ Word Template
| I Save = Save the document as a template that can
- be used to format future documents.
= @ Word 97-2003 Document
H 3aVE As 5 Save a copy of the document that is fully
compatible with Word 97-2003,
(2] File name: Invoice template . dokx

Save as bype:

Save

Notes:

= A .dotx file is a Word 2007 template. Users of Office 2003 or XP will not be able to
open this type of file properly unless a compatibility pack has been downloaded from
the Microsoft web site and installed on their computer. If the template needs to be
opened on computers using Office 2003 or XP use the .dot file format when saving
the template.

= The default location for saving template file a local folder called Templates. If others
need to use the template, consider changing the Save in: location to a folder on a
network drive.
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Creating a document from a custom template
1. Go to the Office button and select New.
2. From the Templates area on the left, select:

a. The ‘My Templates’ option, if the template is saved locally to the Templates
folder; or

b. The ‘New from Existing’ option, if the template is saved elsewhere.

3. Select the template file and click ‘Create’ (for option a above) or ‘Create new’ (for
option b above).

o — b_"‘ ) -~ (15 @ Templates @ Templates
E@ a | Blank and recent b | Blank and recent
j Installed Templates Installed Templates
MNew
My templates... My templates...

Mew from existing... Mew from existing...

Modifying a custom template
1. Go to the Office Button and select Open.
2. Navigate to and select the template file, and click Open.

3. Make the desired changes to the template and click the Save button on the Quick
Access Toolbar.

Alternatively the current template file can be modified and then overwritten as follows:

1. Create a new document from the template file (as outlined in ‘Creating a document
from a custom template’ above).

2. Make the desired changes in the new document, then go to the Office button, select
Save As then Word template.

3. Navigate to where the template is currently saved, and click on the template file to
select it.

4. Click Save and overwrite the current template file with the updated version.
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Practice Activity: Templates

Open Personal details.
Save the file as a template called Employee details in the Templates folder.
Close the template file.

Create a new file from the Employee details template.

ok wh =

Add two new rows at the bottom of the table as shown below:

Current job title

Current salary

6. Resave the file as a template called Employee details in the Templates folder
(overwriting the template file you saved in step 2 above).

N

.Close the template file.
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